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Dear customer!

Congratulations for purchasing one premium quality SHARKOON 
product.
For a long life time and to take full advantage of this product we 
recommend that you read this manual completely.

Have a good time with our product!
SHARKOON Technologies GmbH

1. Features

•	 1-port (USB LANPort 100) or 4-port (USB LANPort 400) USB 	
	 server
•	 Allows connecting any USB device to a LAN
•	 Suitable for any USB devices (e.g. USB sticks, USB printers, 	
	 external hard disk drives etc.)
•	 External interfaces (USB LANPort 100): 1x USB2.0, 1x LAN 	
	 (RJ-45)
•	 External interfaces (USB LANPort 400): 4x USB2.0, 1x LAN 	
	 (RJ-45)
•	 Compact design
•	 Power LED and reset button



USB LANPORT 100 / 400

EN
G

LISH

2. Parts and accessories

•	 USB LANPort (A)
•	 Power adapter (B)
•	 Patch cable (C)
•	 Tools CD incl. software and extensive manual (PDF / D)

A

B C
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3. The device at a glance
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A 	 – 	 Network connector (RJ-45)
B 	 – 	 Power connector (5 V / DC)
C 	 – 	 Reset button
D 	 – 	 Power LED
E 	 – 	 USB connector(s)

USB LANPort 100 USB LANPort 400
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4. Getting started

4.1 Hardware installation

1. 	 Connect the included patch cable to the USB LANPort’s  
	 network connector and an available network connector of  
	 your switch/hub/router/PC or similar.
2. 	 Connect the included power adapter to the USB LANPort and  
	 a wall outlet. The device will boot automatically.

4.2 Software installation (Windows for example)

1. 	 Insert the included Tools CD into your CD/DVD drive.
2. 	 Use the Windows Explorer to open the directory of the 	
	 inserted Tools CD.
3. 	 Double click (left mouse button) “Setup.exe”.  The installation 
	 will start.
	 Follow the installation wizard’s instructions.
4. 	 To complete the installation you will be prompted to reboot  
	 your PC. Confirm this indication.
5. 	 After successfully rebooting your system, the following icon 
	 will appear on your desktop:

 

	
	 Double-click (left mouse button) this icon to launch the 
	 software.

	 Note:
	 You need to install this server software on every PC from  
	 which you want to access the USB LANPort.

6. 	 Connect the USB device(s) to the USB port(s) of the 
	 USB LANPort.
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5. The user interface

First set the desired language for the user interface:
File > Setting > Languages:

 

 
 

A 	 – 	 Menu bar containing the entries “File“, “View“ and “Help“
B 	 – 	 USB server with appropriate IP address
C 	 – 	 USB device attached to the USB server (for example a 
	 	 USB stick). Green icon = device available, red icon = 
		  device not available
D 	 – 	 “Search“ button: by clicking (left mouse button) this 
		  button the search for devices connected to the USB 
		  server will be started
E 	 – 	 “Config“ (configuration) button (only shown when the 	

A
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	 	 USB server has been selected): left-click this button to 
		  open the USB server’s web interface
F 	 – 	 “Connect“ button (only shown when an attached USB 
	 	 device has been selected): left-click this button to select 
		  the according USB device and to lock it for other users

Note:
The software will detect the connected USB server and asso-
ciated devices automatically. Furthermore the USB server sup-
ports automatic and manual IP address assignment; automatic 
address assignment via DHCP is selected by default.
In case your firewall prompts you during the installation process 
allow the USB server to access the respective network resour-
ces.

5.1 The user interface’s menu bar

5.1.1 The File menu

The File menu offers the submenu “Setting“ and the entry “Quit“.

5.1.1.1 The Setting submenu

 The Setting submenu contains the entries “Polling Interval“ and 
„Receive Disconnect Request“ as well as the submenu “Langu-
ages“
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1. 	 The “Languages submenu”:
	 From the flip-out menu select the desired language for the 
	 user interface.

2. 	 The “Polling Interval” entry:
	 This entry lets you define whether and – if yes – in which 
	 interval the USB server will poll the status of the connected 
	 USB device(s).
	 After selecting this menu entry the following window will 
	 open up:

 

	 Enter “0” to deactivate this function.
	 Enter any value > 20 seconds to activate this function and to 
	 set the interval.

3. 	 The “Receive Disconnect Request” entry:
	 In case a device is already in use by user A and user B wants 
	 to access this device simultaneously he can send the follow- 
	 ing request to B:
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The receipt of this automated request may be turned on/off here.

5.1.1.2  Exiting the program (Quit entry)

Select this menu entry to quit the program.

5.1.2 The View menu

The view menu offers the alternatively selectable entries “Ser-
vers And Devices“ and “Devices Only“.

1. 	 The “Servers and Devices” entry:
	 Select this option to display both the USB Server and  
	 connected USB devices in the user interface.

2. 	 The “Devices Only” entry:
	 If this option has been selected, the user interface will only  
	 show the attached USB devices.
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5.1.3  The help menu

Via the “About“ entry you can access some program informa-
tion.

5.2  The context menus

By right-clicking the USB server entry or the devices entry in the 
user interface you can access the according context menus.

The devices context menu differs depending on whether the de-
vice is available (green icon) or blocked (red icon).
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5.2.1  The USB server context menu

A

B

C

E

D

A 	 – 	 Enter a name for the USB server here
B 	 – 	 DHCP on (manual IP address off) / DHCP off (manual IP  
		  address on)
C 	 – 	 Define which port(s) shall be connected during program 
	 	 start-up automatically
D 	 – 	 “Set“ saves your changes, “Cancel“ discards them
E 	 – 	 The entries “Backup Firmware“, “Update Firmware“, 
		  “Change Password“ and “Restart Server“
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5.2.1.1 Backup Firmware

The USB server offers the possibility to backup the firmware.
The pop-up window (see below) already offers a target path for 
the backup file. Via “Browse” you can change this default path. 
“Submit” starts the backup, “Cancel” will terminate the action.

 

5.2.1.2 Update Firmware

In case you have a more actual version of the USB server’s firm-
ware available you may update the current firmware version via 
this entry. With “Browse” you select the locally saved update 
version. “Submit” starts, “Cancel” terminates the update pro-
cedure.
A current firmware version can be found at www.sharkoon.com.

 

5.2.1.3 Change Password

In this input window (see below) you may assign a new pass-
word. This password is required to configure different settings 
of the USB server.
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5.2.1.4  Restart Server

Select this entry to restart the USB server. A restart may be ne-
cessary when the server does not react or other problems have 
occurred.
You may also force a restart by pressing the reset button on the 
device.
 
5.2.2  The USB devices context menu

1. 	 The details entry displays some information regarding the 
	 attached devices.
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2. 	 The “Request Disconnect“ entry is used to send a message  
	 to the current user of a blocked device to ask him to unblock  
	 the device:

 

	 This entry only appears when the device is blocked (red icon).

6. Configuration via web interface

1. 	 Start the USB server software by double-clicking (left mouse  
	 button) the program icon.
2. 	 Start your browser.
3. 	 Enter the USB server’s IP address (without “http://” or  
	 “www” put in front) into the browser’s address line. The IP  
	 address assigned to the USB server can be found from the  
	 user interface of the USB server program:
 

	 or from the USB server’s context menu:



USB LANPORT 100 / 400

EN
G

LISH

	 Alternatively select the USB server’s entry from the user  
	 interface and click “Config“:

4. 	 The browser will display the USB server’s web interface  
	 afterwards.
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6.1 Device Status

A 	 – 	 Left-click the link to select the respective entry.
B 	 – 	 This area displays various USB server information:  
	 	 Server Name, Manufacturer, Model, Firmware Version  
	 	 and Server Up-Time (time elapsed since server has been  
		  started).
C 	 – 	 This area displays various information regarding the  
	 	 connected device: Device Name, Link Status, Device  
		  Status and Current User.

A

B

C



USB LANPORT 100 / 400

EN
G

LISH

6.2 Network

 
A 	 – 	 Left-click the link to select the respective entry.
B 	 – 	 This area displays the current network status: IP Setting  
	 	 (automatic or manual IP address assignment), IP Address  
	 	 (IP address assigned to the server), Subnet Mask, MAC  
		  Address (the server’s MAC address).
C 	 – 	 This area allows configuring the network settings.
		  With “DHCP Setting” you define whether the network  
		  address shall be assigned automatically (Enable) or  
		  manually (Disable).
		  The respective manual settings you enter into the areas  
		  “IP Address” and “Subnet Mask”.
		  With “Server Name” you may define your own server  
		  name.
		  To protect the server settings from unwanted changes  
		  you need to assign a “Password”.
D 	 – 	 “Submit” saves your changes while “Clear” will discard  
		  them.

A
B

C

D
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6.3 Reset device

A 	 – 	 Left-click the link to select the respective entry.
B 	 – 	 Perform a reset after entering the assigned password  
		  into the “Password” area and confirm by clicking the  
		  “Submit” button.

6.4 Factory Default

A

A

B

B

A 	 – 	 Left-click the link to select the respective entry.
B 	 – 	 To recover the factory default settings enter the pass- 
	 	 word into the “Password” area and confirm by left- 
		  clicking the “Factory Default” button.
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6.5 Firmware Update

B

C

A 	 – 	 Left-click the link to select the respective entry.
B 	 – 	 To perform a firmware update, download the respective  
		  software from our website and save it locally. Then enter  
		  the according password (see above) into the “Password”  
		  area and select the source path of the local update file  
		  with “Search”.
C 	 – 	 “Submit” will confirm and start the update procedure.  
		  “Clear” cancels the action.

6.6 Password Change

 

A

B
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A 	 – 	 Left-click the link to select the respective entry.
B 	 – 	 To change the current password enter it into the  
	 	 “Current Password” area, then enter the newly assigned  
		  password into the “New Password” area. Confirm the  
	 	 new password by re-typing it into the “Confirm New  
	 	 Password” area, Left-clicking “Submit” will complete  
		  this procedure.

7. 	Important notes

1. 	 After you have successfully installed and configured the  
	 USB LANPort (as described above) connect any USB device  
	 to the USB plug(s) of the device.

2. 	 You need to install the server software on every PC, from  
	 which you want to access the USB LANPort.

3. 	 Your operating system will treat the connected USB device  
	 as if it was directly connected to the PC. This means that  
	 potential drivers (e.g. printer drivers) need to be installed on  
	 the system (for further details refer to the manuals of the  
	 according devices).

4. 	 As the devices will be handled like directly attached hard- 
	 ware, we suggest to remove USB memory devices (USB  
	 sticks, external hard disk drives etc.) using the “Safely  
	 remove hardware” function before terminating the connec- 
	 tion via “Disconnect”.
	 The server software will also prompt you with the following  
	 note:
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	 Other USB devices such as printers, scanners etc. do not  
	 require this step and can directly be disconnected.

5. 	 The USB to IP translation may cause a decrease in transfer  
	 speed compared to the native operation of the USB devices  
	 and is caused by technical means.

8. Example of use (Windows XP)

User A at his desktop wants to access a USB stick that is directly 
connected to the USB LANPort.
For this purpose he runs the server software which already has 
been installed on his system.
The user interface of the server software will display the USB 
server and the associated device.
The green icon indicates that the device is available (fig. 1).
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fig. 1

To access the device A selects it (1x left click) and then clicks (left 
mouse button) the “Connect” button.
The operating system will install all required drivers and after-
wards the USB stick will be shown as removable medium in the 
Windows Explorer (fig. 2).

fig. 2
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User A now has access to the USB stick and can use it as if con-
nected directly to his PC.

User B also wants to access the USB stick connected to the USB 
LANPort. He also runs the already installed server software.
The user interface will display the USB server and the associated 
device.
The red icon indicates that the device is currently in usage and is 
not available, the “Connect” button is set in grey (fig. 3).

fig. 3

Using the devices context menu (fig. 4), B now can send a reque-
st (fig. 5) to A who is currently blocking the device.
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fig. 4

fig. 5

This request will be displayed on A’s screen. A can decide 
whether he agrees to release the device “Yes” or not “No”.

As soon as A has released the device, B will receive the follow-
ing prompt and can “Connect” to the device.
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When B does not need the device any longer he can cancel the 
connection via “Disconnect” and release the device for further 
usage.
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Legal disclaimer

Warning:
For potential loss of data, especially due to inappropriate hand-
ling, SHARKOON assumes no liability.

All named products and descriptions are trademarks and/or re-
gistered trademarks of the respective manufacturers and are ac-
cepted as protected.

As a continuing policy of product improvement at SHARKOON, 
the design and specifications are subject to change without prior 
notice. National product specifications may vary.

The legal rights of the enclosed software belong to the respec-
tive owner. Please observe the license terms of the manufac-
turer before using the software.

All rights reserved especially (also in extracts) for translation, 
reprinting, reproduction by copying or other technical means. 
Infringements will lead to compensation.
All rights reserved especially in case of assignation of patent 
or utility patent. Means of delivery and technical modifications 
reserved.

© SHARKOON Technologies GmbH 2009
www.sharkoon.com


